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Introduction
Welcome to Essential Office Applications 1!  This is the first book in the Essential Computer Skills  
curriculum, which is being developed to provide basic computer skills lessons for home school 
students.    This is “computer skills curriculum for home schoolers, by home schoolers.” 

The intent of this collection of lessons is not to offer a complete user's guide to office applications. 
Instead, these lessons will provide knowledge of the basic aspects of Word Processing, Spreadsheets, 
and Presentations that are often unknown or mis-used in today's workforce, but have been essential in 
my own professional experience.

The first 5 lessons will cover the basics of Word Processing. (If you have used word processors a lot, 
you may know some of the material already.)  Lessons 6, 7, and 8 will give a good introduction to the 
basics of using Spreadsheets.  Lessons 9 and 10 will teach using a computer to create professional-
looking Business Presentations.  After completing these lessons, the student will have a good 
foundation for using these types of applications in a real work environment.

How to Use the Curriculum
In reality, if you are homeschooling you can use this curriculum any way you want!  That is the beauty 
of homeschooling.  These 10 lessons make a great introduction for younger students (ages 10 to 13) to 
be prepared to do their school assignments and more on a computer.  

If you want to count this curriculum as a full class and grade the work, you will want to complete the 
lessons and all exercises and quizzes.  I suggest the following approach to allow the student to go 
through one lesson each week.

Day 1:  Work through the lesson and try some of the examples as you go
Day 2:  Take the quiz, looking back through the lesson for the answers if necessary

 Do the 1st exercise for the lesson
Day 3:  Do the 2nd exercise
Day 4:  Do the 3rd exercise
Day 5:  free day, or catch up if not finished with all the exercises

The work for each day should take less than an hour, and the entire workbook can be completed in 10 
weeks of time.  Some lessons may take more than the 1st day to complete, so adjust the schedule if you 
need to.  After the 10 lessons are complete, you could have the student do other assignments on the 
computer (like writing a paragraph for English, etc.) and count it as computer skills work too.  In this 
way, they can continue to practice what they have learned.

High school students:  to complete a full semester of work, you will likely want to have older students 
do some further computer lessons in addition to these 10 lessons.  My suggestion for high school 
students is to go through both Essential Office Applications books in 1 semester, which is a total of 18 
lessons.  The lessons in Book 2 are geared toward intermediate skills appropriate for ages 13 and older.

Grading:  My suggestion for grading is as follows:

Quizzes:  count each question as 1 point  (Total possible:  84 pts)
Exercises:  count each exercise as the number of points indicated, if the student completed it

correctly (Total: 290 pts)
Final Exam: count each question as 2 points  (Total:  40 pts)

Final % Grade = Total points the student received divided by 414 possible points 
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About OpenOffice.org and Other Office Applications
I will be using the OpenOffice.org 2.4 applications in my examples.  I have chosen OpenOffice.org for 
the following reasons.  1) It is FREE! You can download it from www.openoffice.org.  2) It is very 
similar to Microsoft Office, and will actually read and save Microsoft documents.

If you use Microsoft Office, all of these features will be available there as well, and the student will 
be able to follow along with these lessons.  Since there are so many Microsoft Office users out there, I 
will point out the most glaring differences between OpenOffice.org and Microsoft Office as we go 
along.  (I will also indicate where the equivalent features can be found in MS Office 2007.)

If you are using a “lightweight” word processor (such as WordPad), or if you don't have a full-featured 
spreadsheet and presentation program, you will not be able to do most of the lessons.  In this case, you 
should get OpenOffice.org and learn to use a full-featured office application.

Installing OpenOffice.org
NOTE: the download file for OpenOffice.org is over 110MB large. Downloading it can take a long 
time.  You can order a CD for this curriculum, which will contain OpenOffice.org and all of the lesson 
examples for this book.  (Go to www.scottosplace.com/EOA.shtml.)

The system requirements to run OpenOffice.org are as follows:
• Windows 98, Windows ME, Windows 2000 (Service Pack 2 or higher), Windows XP, 

Windows 2003, Windows Vista
• 128 Mbytes RAM 
• At least 700 Mbytes available disk space 
• 800 x 600 or higher resolution with at least 256 colors 

To download your free version of OpenOffice.org, go to their website at www.openoffice.org and 
click on the “download” link and follow the instructions to get the latest version.  Choose to save the 
file to disk, and start the download.  

When the download is finished, find the file that you saved (it may be on your desktop, named similar 
to “OOo_2.4.0_Win32Intel_install_en-US.exe”) and double-click it to begin the install.  Follow the 
instructions to finish the installation  If you have any trouble with downloading or installing the 
program, look for detailed instructions and help on the OpenOffice.org website.

About the Author
You may be asking yourself, How does this guy know what is essential?  That is a very appropriate 
question, so let me detail just a little bit of my own experience for you. 

I have been working in the Information Technology industry for about 20 years.  In that time I have 
authored three published technical papers and created countless software design specifications for 
various organizations and companies.  I have given technical presentations to groups of as many as 500 
people, and I have created spreadsheets to track such things as software bugs and employee resource 
allocation. In my personal life, I have written a full-length novel which I have self-published.  Believe 
it or not, I have done all this using the types of office applications that are taught in these lessons!

During the same time, I have quite frequently been asked to modify documents that were written by 
others. I often end up frustrated, lamenting that if only the original author had known how to use a 
word processor better, then my job would be so much easier!  So I have a pretty good understanding of 
this kind of essential knowledge for office applications, which I hope to be able to pass on to you.

My wife and I have been home schooling for 9 years, and my two boys have been privileged to be the 
first students to go through these lessons.  I believe other home schoolers will enjoy them too.
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Lesson 1:  The Basics of Working with Documents
This lesson will teach some of the basics of working with documents in a word processor. Not all steps 
are pictured, so in order to fully learn the information, you will need to follow along and actually DO 
the steps as you read them.  
A document is defined as “a writing that contains information” or “a piece of work created with an 
application, as by a word processor.”  Our goal is to learn how to create written documents in a word 
processor.

Microsoft Word 2007 Users:
In Word 2007 there are no drop-down menus at the top of the window.  Instead, all the options are 
found in the tabs across the top, in an area called the ribbon.  Below is how the ribbon looks in Word 
2007, and I have noted where to find the options that are discussed in this lesson.  Throughout this 
workbook, I will show where to access the various options in Office 2007, with a picture and a text 
box just like here.

Creating a New Document
The first step to create a document is to run your favorite word processor.  I hope you know how to do 
this, but the easiest way (in Windows XP) is to choose it from the Start menu.  (The OpenOffice.org 
word processor is called Writer, and can be selected from the OpenOffice.org folder in All Programs 
in the Start menu.)

Within your word processor there should be a menu option 
to create a new file.  The following figure shows the File 
menu in OpenOffice.org Writer.

Select the New option, and 
then pick Text Document.

Click on the Office logo
to see the New, Save,
and Open options for

this lesson.
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Saving a Document
After the previous step, you will most likely have a new 
window with a blank (white) document.  If your word 
processor asks you what type of document to create, there 
should be a choice for “blank document” or something 
similar.

Go ahead and type something into your new document. 
Just a sentence or two is fine. Now we will save this 
document into a file on your computer.

In the Save As window, type in example1 as the name for your document file and press the Save 
button.  (We'll use this document later.)  That's all there is to it!  Now you can close the document and 
you will be able to come back to it later.  Go ahead and close your example1 document now, by 
selecting Close from the File menu.

Editing an Existing Document
To open a previously saved document, click on the File menu and select Open...  This will bring up 
the Open File window, shown below.  Open the example1 document that you saved earlier.

Click on the File menu again 
and select the Save option.

First, click on the name of the 
file you want to open...

...then click on the 
Open button.
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Now type in another sentence or two.  You can start at the end of your document simply by clicking 
the mouse anywhere below where you typed before.

Here are some tips on typing your text in a word processor:

• Do not press the Enter key on the keyboard at the end of each line – your word processor will 
automatically go to the next line as you type.

• Press the Enter key when you want to start  a new paragraph.

• You can use the Tab key on the keyboard to indent paragraphs, but there is a better way to do 
this. (We'll get to that in lesson 2.)

• To erase a word or a sentence (or a paragraph, or an entire page) you can first highlight the 
words you want to erase, by holding down the left mouse button as you move the mouse across 
the text.  Your highlighted text should look something like this.  (This is also known as 
reverse-video because the background color and text color are reversed.)  See the example 
below.

This is known as selecting some text.  With your selected text highlighted, you can press the 
Delete key on the keyboard, and the selected text will be deleted.

Press the left mouse 
button here...

...then hold and 
drag to here.
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To select or highlight several lines of text, place the mouse cursor in the left margin, next to the first 
line you wish to highlight, press and hold down the left mouse button, and move the cursor down the 
page along the left margin.  You should see the lines highlighting as you go.  

(Another way to select text is to place the cursor at the beginning of the text you want to select, then 
press and hold down the Shift key on your keyboard.  While holding down the Shift key, press the 
arrow keys on your keyboard to move the cursor over the the text, and it will be highlighted.)

Let's pretend you just deleted something that you didn't want to delete.  OOPS!!   
Don't despair, you can Undo most actions in a word processor.

Microsoft Word 2007 Users:

Click on the Edit menu and 
the first option is Undo.

Press the left mouse 
button in the margin...

Then hold and drag 
to here...

Click on this icon to
access the Undo

option.
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Type a couple of short paragraphs on your page.

Highlight 2 lines in the middle of your text, and delete them.

Use the Undo feature to get your deleted lines back.

After you have typed some more text into your document, you can save your changes by selecting the 
File menu and then selecting either Save or Save As....  If you select Save you will not be asked to 
type in a file name, and your changed document will replace the one that you saved before.  If you 
want to keep both the first one and the new version, you should select Save As... and type in a new 
name.

Go ahead and select File and Save As... and then type in example2 and click on the Save button.

NOTE:  You can also create, open, and save documents by clicking on the icons at the top-left of the 
screen.

Organizing Your Documents
Your documents will usually be saved in your My Documents folder by default (if you are using 
Microsoft Windows).  If you create lots of documents you should create folders to organize your 
documents.  It is hard to find the document you want if you have a large number of files in the same 
folder.

For example, make a folder called Homeschool in which to place all your home school documents. 
Then when you select Save As... to save a document for your home school work, you can select your 
home school folder in the Save in... field before pressing the Save button.

Unfortunately, learning how to make folders in Windows is not covered in this curriculum.

Create New

Open

Save
Note that this is not 

Save As...

TRY
THIS!
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Lesson 1 Quiz

1. What is the definition of a document?

2. Which option in the File menu should you choose to save your changes with a different 
document name?

3. What is another name for highlighting some text using the mouse?

4. When typing a paragraph, when should you press the Enter key?

5. What should you do if you accidentally delete a sentence?
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Lesson 1 Exercises

Exercise 1 (10 pts):  Use your word processor to create a new document, and write a letter to a friend. 
Make it as long as you want, but at least include several sentences and more than one paragraph. 
Remember what you learned in the lesson: do not use the Enter key unless you want to start a new 
paragraph. To delete letters or words, use the Backspace key to “back over” the letters, or highlight the 
words and press the Delete key.

When you are finished, save your letter as “myLetter”.

Exercise 2 (10 pts):  Using what you have learned, create a new document and start a diary.  On the 
first line, type today's date.  Then press the Enter key, and write at least 1 paragraph about what you 
did today.  When finished, save this document as “myDiary”.

Exercise 3 (10 pts):  Do this exercise the day after you complete Exercise 2.  Open your “myDiary” 
document and add a paragraph (or more) about what you did since your first entry.  Make sure you 
skip a line or two before your new entry (by pressing the Enter key a couple times), and begin your 
new entry with today's date just like in Exercise 2.  When finished, save the document without 
changing the name.

Exercise 4 (5 pts):  Wait a day after you complete Exercise 3, and add another entry into your diary 
document. Be sure to save it again when you are finished.

If you like keeping a diary, you can continue adding entries into this document as often as you wish!
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